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Documentation Updates 

The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version.  

• Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 
http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

Note: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site:  
http://www.adobe.com/ 

http://h20230.www2.hp.com/selfsolve/manuals�
http://h20229.www2.hp.com/passport-registration.html�
http://www.adobe.com/�


 3 

In This Version 

Service Manager Version 9.30, build 201, patch 3 (SM 9.30p3) includes several customer requested software 
enhancements and fixes. Refer to the sections below for information about the defects, enhancements, and 
known issues included in this release. 

• Enhancements 

• Server updates 

• Web client updates 

• Windows client updates 

• Application updates 

• Documentation changes 

• Known issues 

Enhancements 

The following enhancements are included in the current software release. 

Global 
ID 

Module Problem  Solution  

QCCR1E
67825 

Server Service Manager needs to 
decompress zip files in JavaScript. 
 
To accomplish this, a new 
JavaScript global method, 
"uncompressFile" has been added.  
It expands a compressed file into a 
specified location, using the 
following syntax:  
uncompressFile(file name, target 
directory);  

Added a new JavaScript global method, 
uncompressFile, to provide this 
capability. 
This method expands a compressed file 
into a specified location, using the 
following syntax:  
uncompressFile(file name, target 
directory);  
Note: If the target directory is not 
specified, the location of the compressed 
file is used. 

Example: 
uncompressFile("c:/test/upgtest.zi
p", "c:/test/test"); 

QCCR1E
19936 

Web Tier In the web client, when the focus is 
not set on an editable field, the 
backspace key should not do 
anything. Currently, pressing the 
backspace key does the equivalent 
of "Back" in the web browser, 
causing the user to be logged out 
and the information the user has 
entered in the form to get lost. 

When the focus is not set on an editable 
field, the backspace key now performs 
no actions; it now only performs normal 
backspace actions when the focus is on 
an editable field. 

QCCR1E
67279 

Web Tier The Service Manager Web Client 
does not support Internet Explorer 
9.  

The Web Client now works with 
Internet Explorer 9.  
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Global 
ID 

Module Problem  Solution  

QCCR1E
71557 

Documentation Documentation is needed on how to 
use the updated configure.jar file of 
the server.  

The Service Manager server 
configure.jar file has been updated to 
enable encryption of the Service 
Manager database login credentials 
(username/password). The following 
describes how to use it. 
To encrypt the database login 
credentials of an installed Service 
Manager system: 

1. Extract the server package (.zip or 
.tar) in this patch, and copy the 
configure.jar file to your <SM 
server installation> directory. This 
will overwrite your old configure.jar 
file if you did not move it to 
somewhere else after your 
installation.  

2 Run the configure.bat file in the 
installed system, without loading 
demo data.  

The database login credentials in 
the sm.ini file now has become 
encrypted strings instead of clear 
text. 

Note: You can still manually 
specify clear-text database login 
credentials in the sm.ini file, 
however HP recommends that you 
encrypt the credentials as described 
above. 

QCCR1E
52251 

Documentation Users cannot find complete and up-
to-date information about products 
that can be used with Service 
Manager, from the link provided in 
the Compatibility Matrix document: 
http://support.openview.hp.com/sc/i
ntegration_catalog.jsp.  

Users can find complete and up-to-date 
information about supported products 
and versions for SM integrations from 
the following link, which is available in 
the "Compatibility with other Hewlett-
Packard products" section of the Service 
Manager compatibility matrix: 
http://support.openview.hp.com/sc/i
ntegration_catalog.jsp  
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Web client updates  

The following items are fixed in the current software release.  

 

Global 
ID 

Problem Solution 

QCCR1E
32210 

Users are unable to view an attachment from the 
web client when getAbsolutePath() in 
Attachment.java returns greater than 255 
characters.  
Note: This issue is most likely to occur on 
WebSphere systems, where the deployment path to 
the temp directory is prefixed by various 
WebSphere nodename and server names and an 
attachment file full path is dependent on the length 
of WAR file name and the installation path of the 
application server.  

The web tier now supports long full paths 
(greater than 255 characters) for 
attachments when running on Linux, 
Unix, or Windows with an NTFS file 
system.  
Note: This issue still exists when, in rare 
cases, the web tier is running on Windows 
with a FAT file system.  

Note: If the user uses a very long file 
name or folder name, which causes the 
full path of the file to exceed 255 bytes, 
the user will not be able to delete the web 
application server's temporary file/folder 
generated on uploading the file (normally 
under the web application server 
installation directory). Deleting the 
temporary file/folder will fail with a 
system warning message that states the 
file name is too long. In this case, the user 
can do the following to delete the file: 

1. Rename the temporary file to a short 
name, and then delete it.  

2. If the deletion still fails, open the 
system command prompt, type "dir /x" 
to display the file's short name and 
then run the "rmdir {short name} /S" 
to delete the folder. 

QCCR1E
55847 

Fields on the userrole.g form are not sized correctly 
in the web client.  

Changed the form style to properly 
accommodate the fields.  

QCCR1E
56885 

When opening a record from a record list and then 
clicking a HOME menu item (a menu item on the 
system navigator) that uses the us.launch.external 
application, the web client hangs. 

When opening a record from a record list 
and then clicking a menu item on the 
system navigator that uses the 
us.launch.external application, the web 
client no longer hangs. 

QCCR1E
57402 

There is no Refresh button on the left navigation 
panel in the web client.  

A Refresh button is now available.  

QCCR1E
61175 

Users are unable to add activities because the 
buttons become unusable after selecting the update 
type in the list of activities. The reason is that the 
detail window is not loaded properly. 

Now when users expand the Activities 
section and select an update type, the 
buttons are available for use and working 
properly. 
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QCCR1E
61860 

When Trusted Sign-On is enabled, the web client 
always displays in English even when passing in 
the lang=<lang> parameter, for example, 
index.do?lang=de.  

Language preference works normally 
when Trusted Sign-On is enabled for the 
web client.  

Note: This is the client-side change for 
this issue. Users must apply this change 
together with the server-side change 
QCCRIE69693. 

QCCR1E
61880 

After updating a few other fields of a problem 
ticket, the user received the following error 
message when updating the Affected CIs field using 
Fill:  
Cannot find related information in device 
using query: true and logical.name#"Work In 

Progress"'. 

Reset the focus field so that when the 
focus is moved, the Web Tier will send the 
correct field to the background and fetch 
the correct records. The error no longer 
occurs. 

QCCR1E
63661 

Keyboard shortcuts in the Service Manager 9.2 
accessible web client were not working for the Save 
display option button. 

For the Save option, keyboard shortcuts in 
Service Manager 9.21 P5 and later have 
been changed to Ctrl+Shift+F4.  

QCCR1E
63989 

Memory usage in the browser increases as it is used 
throughout the day.  

Removed a memory leak that occurred 
due to HTML event handlers not being 
freed right after a page reloads or closes.  

QCCR1E
64537 

Read-only fields are displayed in gray text instead 
of black text when running a Web client with 
Internet Explorer versions 7 and 8. 
Here is an example scenario: 

1. Log in to the Windows client as a system 
administrator. 

2.  In Format Control, open record 
"IM.update.incident". 

3. On the Calculations tab, add a new row with 
the following values:  
initial: true 
calculation: $atx.readonly.field=true 

4. In Forms Designer, open the 
IM.update.incident form in Design mode. 

5. On field "action" (label: Description), add the 
read-only condition: [$atx.readonly.field]=true 

6. Open the web client in Internet Explorer 7 or 8, 
and log in to the web client as a system 
administrator. 

7. Search and open an incident record with a read-
only Description field. The Description field is 
displayed in gray text with a light gray 
background.  

Read-only fields are displayed in black 
text with a gray background.  
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QCCR1E
65001 

Users are not able to do simple things like approve 
a change request due to the following error:  
Field contains an invalid numeric value 
(display,show.rio) 

 
The following is an example scenario: 

1. Log in to the Windows client as a system 
administrator. 

2. In the command line, type dbdict and then 
open the cm3r dbdict record. 

3. On the Fields tab, select descriptor and click 
New Field/Key to add a new field with the 
following values: 
Name: number.array 
Type: array 
Subtype: number 

4. Click OK and select SM Alters. 

5. Log out and then back in. 

6. In Forms Designer, open the 
CM.change.closure form in Design mode. 

7. Add a Comfill object with the following 
properties: 
input: number.array 
array length:2 
value list: 1;2 
display list: Americas;EMEA 

8. Save the format. 

9. Go to Change Management > Search Changes, 
to open a change record in the Change 
Implementation phase. 

10. Scroll down to tasks and double-click the one in 
the table. 

11. Enter the actual start/end values, click Close 
Task, enter closure comments, and click OK. 
This allows you to advance cm3r. 

12. Click Close Phase. 

13. Select the change record again. 
RESULT: The form should be 
CM.change.closure now and the phase is 
Evaluation and Change Closure. 

14. Select the Comfill dropdown added previously 
and choose the Americas value. 

15. Enter closure comments, and click Close 
Change. 
RESULT: The system prompts "you have 
unsaved changes to record, save now?" 

16. Click Yes, and if prompted to force close related 

Revised the handling of read-only Comfill 
widgets so the proper value will be posted.  



 8 

interaction click No. 
RESUL: The change record is closed. 

17. Log in to the web client as a system 
administrator. 

18. Go to Change Management > Search Changes, 
and open the change record. 

19. Click Cancel. 
RESULT: The following error message appears: 
“Field contains an invalid numeric value 
(display, show.rio).” 
Clearing the value for number.array prevents 
the error.  

QCCR1E
65736 

The web client sometimes fails to display the 
toolbar on search screens (for example, when 
searching incidents). 

Pages are now properly loaded only after 
all required content from the server is 
available. The toolbar now displays and 
works properly. 

QCCR1E
66046 

In the web client, when closing a tab that was 
opened from another tab, the user is not redirected 
to the originating tab. 

When closing a tab that is opened from 
another tab, the user is now redirected to 
the originating tab. 

QCCR1E
66150 

The cursor does not show the correct position once 
the web page is refreshed. For example, once the 
web client prompts an error to a field, the expected 
result is that the cursor should focus on that field. 
The focus should be set to the target field after the 
web page is loaded.  

The focus is now reset to the target field 
after the web page is refreshed.  

QCCR1E
66835 

Need an option to disable the login button in the 
Web Tier after an operator clicks it one time. This 
will prevent issues when users get the message that 
they have reached the maximum number of 
sessions because they have clicked the login button 
multiple times.  

The login button is disabled when the 
login form is submitted by either clicking 
the button or pressing the enter key while 
the cursor is blinking in one of the input 
fields.  

QCCR1E
67011 

Users lose unsaved ticket information after closing 
a QBE list within another thread.  

Corrected a tab update issue where it was 
using the wrong URL after displaying a 
hover form.  

QCCR1E
67051 

After creating a new transition, if the Transition 
Type drop-down list is expanded, the users can edit 
the transition type of the existing transitions. 

The Transition Type drop-down list was 
modified to collapse after creating a new 
transition so it does not allow existing 
transitions to be edited. 

QCCR1E
67134 

When a Format Control validation fails on a field 
that is inside a collapsed group, the focus does not 
jump to that field.  

A group that contains a focused field is 
automatically expanded to show this field.  
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QCCR1E
67196 

When users attempted to add an attachment to a 
ticket (while leaving the Specify File Location field 
empty) and then clicked OK, they received a logged-
out message in the Attachment window. If they 
attempted to continue to work in the session, a 
login screen appeared. 
Note: The Web Tier was deployed on WebSphere 
7.0.  

When users attempt to add an attachment 
to a ticket (while leaving the Specify File 
Location field empty), the OK button is 
disabled, unless the user selects an 
existing file from the file chooser.  

QCCR1E
67181 

The user receives the following error message when 
double-clicking on a message (for example, "No 
records found") on the message bar in the web 
client: 
java.lang.NullPointerException at 
com.hp.ov.sm.client.common.util.CustomTimeZo
ne.getOffset(CustomTimeZone.java:222) at 
com.hp.ov.sm.client.webtier.MessagesAction.g
enerateMessagePane(MessagesAction.java:168) 
at ...  

The error no longer occurs and the 
message now displays correctly. 

QCCR1E
67494 

When there are two notebook tabs and the second 
one contains a Comfill field in a table column, the 
value of the Comfill column cannot be saved if the 
focus is moved to the first tab before saving.  

Value of the Comfill widget in a table can 
be saved when the focus is changed.  

QCCR1E
67758 

When searching changes in Service Manager 9.21, 
fill-enabled data on a Comfill object that is Select 
Only cannot be deleted on the web client. If a user 
uses the Fill option, chooses a value, and then 
realizes the chosen value is incorrect, highlighting 
the value of the field and removing the value does 
not work. Pressing the backspace or delete key does 
not work either. 

Users can remove the value even when 
the combo box is Select Only.  

QCCR1E
68021 

In the web client, Boolean values set in one 
notebook tab are not saved when focus is moved to 
another notebook tab.  
 
Note: This notebook tab is part of a sub-group 
under a group.  

Boolean values are saved properly in the 
notebook tab when focus is moved to 
another notebook tab. 

QCCR1E
68068 

The following JavaScript error occurs in the web 
client when the user presses the ">>" button to 
expand the tool bar: "Object doesn't support 
this property or method".  

The error no longer occurs.  

QCCR1E
68089 

In the Workflow Viewer, the phase name overflows 
if the length of phase name exceeds the phase 
width. 

Phase names now wrap to fit within the 
workflow phases. 
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QCCR1E
68131 

The Tomcat web application server instability 
occurred intermittently at least once a week. A 
large amount of null pointer exceptions were found 
in the web tier's log file:  
 
[ERROR] null java.lang.NullPointerException 
at 
com.hp.ov.sm.client.workflow.viewer.Instance
Viewer.load(InstanceViewer.java:101) 
 
In addition, in the Service Manager system where 
this issue occurred, there are many changes records 
that contain an empty approval.status field value, 
which is different than the out-of-box logic. This is 
not necessarily incorrect depending on the custom 
change flow logic, however Service Manager should 
have not thrown null pointer exceptions when the 
approval.status field is empty on the client side.  

Modified the code so that these null 
pointer exceptions are fixed. The web 
application server is now working 
properly without intermittent instability 
issues.  

QCCR1E
68312 

In Internet Explorer 7, the Web Tier hangs when 
the user clicks any button in the toolbar. 

In Explorer 7, the Web Tier no longer 
hangs when the user clicks any button in 
the toolbar. 

QCCR1E
68516 

JavaScript files remain cached in user's browser, 
even when the user updates the web application.  

Changed the default max-age value of 
'Cache-Control' property of 'cacheFilter' 
bean from 1296000 seconds to 28800 
seconds to avoid some cache-caused 
issues.  
 
Important: Web user's browser cache will 
not automatically get refreshed after this 
value is changed and the web application 
server is restarted. For this reason, web 
users may have to manually clear their 
browser cache before logging in to the 
updated web client, as the user's cache 
may contain outdated web resources that 
are not expired based on the old max-age 
value.  

QCCR1E
68497 

Two buttons ("Previous" and "Cancel") on the 
Contribute Knowledge form do not display the 
button name in the Web Tier. 

The Web Tier templates for Contribute 
Knowledge have been updated to properly 
display the button names.  

QCCR1E
68704 

The hover form in Service Manager 9.21 P3 HF2 
caused serious browser lockups and issues when it 
was used on an array field. Symptoms included 
delays in the pop-up being displayed, accompanied 
by an audible clicking noise.  

The pop-up displays in a timely manner 
without an audible clicking noise.  

QCCR1E
68738 

The list/listdetail/detail panel in the navigation 
cannot be displayed in the web client when 
deployed in Jboss5.1.  

The list/listdetail/detail panel displays 
correctly.  
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QCCR1E
69005 

Selecting a record in a record list caused the whole 
record list to refresh, which caused a performance 
issue.  

When a record is selected in a record list, 
the record list is not automatically 
refreshed.  

QCCR1E
69006 

In the web client, forms with multiple fields 
referencing the same input do not honor the Visible 
Conditions of the fields. 

If Visible Conditions of combos are 
mutually exclusive, only one combo is 
displayed.  

QCCR1E
68989 

On a form that contains Dynamic View Dependency 
conditions, the dependency result is incorrect after 
the user clicks Validate Format or presses Enter. 

The dependency result is now correct.  

QCCR1E
69123 

When a change request is opened, if the workflow 
size is larger than the Workflow Viewer, scroll bars 
appear in the Workflow Viewer and Workflow 
panel. When the user scrolls with the mouse in the 
Workflow Viewer, the workflow enlarges. 

The additional scroll bar in the Workflow 
panel is removed.  Workflows now fit into 
the Workflow Viewer. The Workflow 
Viewer scroll bar is used to navigate the 
larger workflows. 

QCCR1E
69188 

When searching knowledgebases in the web client, 
the following error message occurs in the browser's 
status bar: 

'cwc' is undefined 

Line: 1 

Char: 1 

Code: 0 

URL: http://<hostname>:<port>/<web 
tier>/cwc/js/cwc.js 

When searching knowledgebases in the 
web client, the error message no longer 
occurs. 

QCCR1E
69216 

The web browser hangs after navigating between 
queues. Often users will get the following message: 
"Internet Explorer Cannot display the web page." 
Users need to delete temporary files and cookies, 
and then restart Internet Explorer to get to a login 
page.  

The web client no longer produces errors 
or hangs when users navigate between 
queues.  

QCCR1E
69316 

In Trusted Sign-On (TSO) mode, when a user 
pressed F5 on the browser multiple times during 
initial communications between the client and 
server, multiple server sessions were established. 

In TSO mode, when the user launches the 
web client in a browser, a login progress 
screen displays, which instructs the user 
to wait and not to refresh the screen. Even 
if the user ignores this warning and 
presses F5 or the refresh button on the 
browser, Service Manager will not 
establish new sessions for the user. 

QCCR1E
69488 

Multiple users are simultaneously disconnected 
from the Service Manager (SM) web client, and 
then directed to the "login again" page (session 
timeout). This creates multiple sessions, which are 
seen connecting back to SM although users have 
not logged in but instead left the browser on the 
"login again" screen.  

Multiple sessions are no longer created for 
clients when there are login problems.  
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QCCR1E
69554 

A Web Client JavaScript error occurs when you use 
the Fill Function in a table in Internet Explorer 7.  

No JavaScript error occurs when using 
the Fill Function in a table in Internet 
Explorer 7.  

QCCR1E
69623 

When the secureLogin parameter in the web tier 
configuration file (web.xml) is set to true, web client 
users cannot log in with a non-blank password.  

Web client users can log in with a non-
blank password when the secureLogin 
parameter is enabled.  

QCCR1E
69829 

The Advanced Filter option "Is Empty" returns the 
error: "Please specify the Comparison Value on the 
Web Tier client only."  

Made the Is Empty option a valid 
condition for the advanced filter so that 
the validation failure no longer occurs. 

QCCR1E
69868 

On a search screen, if the user adds a Comfill whose 
value is "masked" using a value-display list and 
then selects a value and searches on it, no results 
are returned. The root cause is that the web tier 
sends the display value to the background, and 
saves this display value to the database.  

Fixed the issue by sending the correct 
data (the value list value) to the 
background so that the correct records are 
returned.  

QCCR1E
70255 

While defining tasks for a Change Model, the Task 
Template drop-down list in the Task Editor 
displays all templates from the templates table. 

The Task Template drop-down list now 
displays only templates from the cm3t 
table. 

QCCR1E
70265 

Contiguous white spaces are automatically replaced 
with one single white space when string values are 
displayed in the Web client.  

White spaces between words are retained. 
Only preceding and trailing white spaces 
are trimmed off.  

QCCR1E
70298 

When the user opens a recordlist in the web client, 
the recordlist is not displayed and the web client 
hangs. This issue occurs when the user switches the 
tab page before the current tab page finishes its 
rendering. Starting from Service Manager 9.2, 
CWC5 assumes that user does not switch tab pages 
when the current page is still loading.  

The mask feature has been improved so 
that the mask persists long enough in a 
user transaction to prevent user operation 
before the current page finishes its 
rendering.  

Additionally, two new web.xml 
parameters have  been introduced to help 
fix this issue: 

• unmaskDeferMillis: Defers the 
unmasking of a browser window after 
an unmask request is issued. This 
parameter relates to how much time 
the client browser needs to finish 
rendering after a page is loaded. The 
client user may feel low application 
performance if set it to a value greater 
than 2000. Additionally, this value 
should not be set to less than 550 
milliseconds unless system 
performance is well characterized.  

— Default: 1000 (milliseconds) 

— Possible values: 750 - 5000 
(milliseconds). 

• autoCloseMaskDelay: Specifies the 
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delay in seconds before which the 
mask is automatically closed. This 
parameter value must be >= 60 
seconds. Uses default value 180 
seconds if any invalid value is 
specified. 

— Default: 180 (seconds) 

— Possible values: No less than 60 
(milliseconds). 

• showMaskCloseButtonDelay (this 
parameter has been deprecated since 
SM9.30p3 Hot Fix 1) 

QCCR1E
70488 

The print icon in the Service Manager web client 
(not the print feature built in the browser) does not 
invoke the operating system's printer list.  

The print icon now invokes the operating 
system's printer list.  

QCCR1E
70624 

In the web client, if the user frequently starts and 
stops background processes from System Status, 
the System Navigator freezes until the user logs out 
and logs in again.  

The System Navigator does not freeze 
after the user frequently starts and stops 
background processes.  

QCCR1E
70654 

The Select All function in multi-select does not 
work on the Service Manager 9.30 P2 Web tier.  

The Select All function in multi-select 
works.  

QCCR1E
71297 

In Internet Explorer 9, users see a blank page when 
running unsupported commands in the Service 
Manager command box.  

A masking behavior has been corrected for 
users who run the web client in Internet 
Explorer 9.  
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QCCR1E
71618 

If the input of a Comfill widget is referenced by the 
dynamic view dependency (DVD) condition of other 
widgets, the Comfill widget is always displayed on 
the form even when its visible condition is 
evaluated to false.  

A Comfill is displayed only when its 
Visibility Condition is evaluated to true.  

Windows client updates  

The following item (identified by reference number) is fixed in the current software release.  

Global ID Problem  Solution  

QCCR1E65372 When the user went into the 
Knowledge Base search form and de-
selected the Incident_Library check 
box, all the other options also 
disappeared.  

When the user goes into the Knowledge Base 
search form and de-selects the Incident_Library 
check box, the other options will remain.  

QCCR1E65709 The tab order is not followed, if 
using a Data Change Event on a 
combo box.  

If Tab is pressed on a Combo Box, it will not start 
Data Change Event so that the focus of the form 
will not change.  

QCCR1E66750 You cannot print a record using the 
File > Print option in the Windows 
client if the record has an 
attachment.  

You can use the File > Print option in the Windows 
client to print a record.  

QCCR1E66833 The Windows client does not display 
the wait cursor, for example an 
hourglass symbol, when transactions 
are still being executed.  

The Windows client now shows the wait cursor 
when transactions are being executed.  

QCCR1E70295 Foreground Color Condition in a 
table widget always uses the default 
color.  

Foreground Color Condition in a table widget now 
takes effect.  
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Server updates  

The following items are fixed in the current software release.  

Global 
ID 

Problem Solution 

QCCR1E
31923 

Client thread crashes when the data length exceeds 
the size defined in the database. 
 
The following is an example:  

1. Log in as a system administrator. 

2. Type contacts in the Service Manager 
command line, and then press Enter. 

3. Click Search. 

4. Select a contact record from the list. For 
example, "BROWN, NICHOLAS". 

5. In the Contact Name field, change "BROWN, 
NICHOLAS" to "BROWN, PPPP...” which 
contains, for example, 350 instances of letter P. 

6. Click Save. 
An error message like this occurs: 

Length (226 bytes) of data for field 
contact.name in contacts exceeds max (140 
bytes), truncated 
(se.base.method,update.record). 

7. Click OK. 

8. Log off and then log back in as a system 
administrator. 

9. Type contacts in the command line, and then 
press Enter. 

10. Click Search. 
The error message "Panne SOAP: An exception 
was raised in native code : error Win32 
EH Exception: 0XC0000005. Client 

terminated." appears and the client session 
ends.  

When the data length exceeds the size 
defined in the database, the data 
truncation error message will still occur 
as expected, however the client will no 
longer crash.  
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Global 
ID 

Problem Solution 

QCCR1E
31928 

Web Service RetrieveIncidentListReque has the 
potential to cause a Java Heap Space out-of-
memory error when retrieving a list of records.  

Updated the server code so that the 
following applies for the request response: 

• When there is neither a start attribute 
nor a count attribute, return all 
records/keys. 

• When there is a valid start value but 
no count attribute, return all records 
starting from the start attribute. 

• When there is a valid start attribute 
and valid count attribute, return the 
number of keys/records starting from 
the start attribute. 

• When there is a negative start 
attribute, return from the first record. 

• When there is a negative count 
attribute, return one record. 

• When the start attribute is bigger 
than the total number of records/keys, 
no record is returned.  

QCCR1E
53128 

Search list contents are grouped incorrectly when 
returning to the record list after updating a record.  

Search list contents are grouped correctly 
when returning to the record list after 
updating a record. The record falls in the 
current group.  

QCCR1E
54192 

When trying to close an interaction by calling 
CloseInteraction from a web service without 
specifying the localSolution field in the request, a 
CXmlApiException occurs with a DocEngine error.  

A normal response will now be returned 
instead of the SOAP Fault. In addition, all 
or part of the following messages will 
occur in the request response depending 
on which field values are missing in the 
request: 

Doc Engine call failed with cc -1 
Msg: ;  

You must enter a Solution to close 
this interaction.  

You must enter a Closure Code to 
close this Interaction. 

Note: To take advantage of this server-
side change, users also need to apply an 
applications fix QCCRIE67647 (by loading 
the relevant unload file). See Application 
unload installation. 

QCCR1E
57292 

Resource lock cannot be released or even cannot be 
killed using the 'k' command due to a plug-in 
termination failure, even though the operator has 
logged out and the session does not exist.  

Added an exception handler for the plugin 
termination procedure so that Service 
Manager can clean up successfully when 
the operator is logged out.  
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Global 
ID 

Problem Solution 

QCCR1E
58862 

The usergrid functionality does not work correctly 
when Service Manager is using an Oracle database. 
When the user attempts to open a saved column 
view by loading a named grid, the correct user grid 
may not be loaded.  

The usergrid functionality now works 
correctly.  

QCCR1E
59527 

In environments deploying a case-sensitive RDBMS 
in combination with a case-insensitive LDAP server 
for authentication, it might be impossible for users 
to successfully log in to Service Manager (SM). 
 
After login, the System Navigator displayed an 
empty tree and the main screen was partially 
rendered, which resulted in an inability to use SM.  

If the LDAP is used for authentication, 
users can now successfully log in with a 
lowercase, uppercase, or mixed-case user 
name and use SM properly after login. 
 
Without LDAP authentication, the case-
sensitivity of login depends on the case-
sensitivity setting of the RDBMS. 
 
Note: To take advantage of this fix, users 
must also update their client to SM 9.30p2 
or later.  

QCCR1E
59746 

Knowledge Management: KMImport is not updated 
to reflect the km-import jar.  

The scripts will no longer hard code the 
jar file name for the class path. Instead, 
the value of the class path will depend on 
all the jar file names in the lib directory. 

Note:  This fix is released with 
9.30p3HF8. To take advantage of this fix, 
find the sm9.30.225-P3HF8_KM.zip file in 
this hot fix.  

QCCR1E
65095 

The "Does not Contain" comparison does not work 
for an ARRAY text field.  

The "Does not Contain" comparison will 
work correctly for an ARRAY text field.  

QCCR1E
65453 

When trying to change the database field 
encryption key using the "sm -changeencrkey" 
command, the command failed to complete and left 
the database corrupted.  

Users can now successfully change the 
database field encryption key using the 
"sm -changeencrkey" command.  

QCCR1E
66601 

Formatting applied to Knowledge Documents was 
lost when the document was used as a solution for 
an interaction.  

When invoking Use Solution on a 
Knowledge Document in an interaction 
record, formatting will be properly applied 
to all HTML tags.  

QCCR1E
66812 

In Service Manager (SM), when the SM 
administrator kills the scauto for OVO client (which 
is not the listener but the scauto for ovo user) in the 
System Status monitor, a message occurs indicating 
that the session is terminated, however it is not 
killed actually. The user session still exists on the 
server and the socket connection is still established.  

The SM administrator can kill the SCAuto 
client user session successfully using the 
"k" command, which means the user 
thread will be terminated on the server 
and the socket connection will be forced to 
be disconnected by the server.  
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Global 
ID 

Problem Solution 

QCCR1E
67061 

When using Service Manager in a non-English 
language (for example, French), the inactivity 
message the user receives is not localized: 
Your inactive HP Service Manager session (UID# 
xxx) will be automatically disconnected in 00:00:45.  

Code has been changed on the Service 
Manager server side so that the inactivity 
timer background process generates the 
message according to the user's login 
language (for example, French). 
Note: For SM applications versions 7.11 
and 9.21 only, a system administrator still 
needs to do the following for users to see 
the localized message. This is because in 
applications 7.11 the above message is 
missing in the out-of-box scmessage table, 
while in applications 9.21 it does exist but 
is not localized. 

1. Open the scmessage table in Database 
Manager. 

2. Add two records for English and the 
target language to the table (for apps 
9.21, only add the target language 
record). 
For English: 
Language Code: en 
Class: scbase 
Message Number: 130 
Text: Your inactive HP Service 
Manager session (UID# %ld) will be 
automatically disconnected in %d 
minute(s) %d second(s).  
For the target language (for 
example, French): 
Language Code: fr 
Class: scbase 
Message Number: 130 
Text: Votre session (UID# %Id) 
inactive de HP Service Manager sera 
automatiquement d?connect?e dans 
%d minute(s) %d seconde(s).  
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Global 
ID 

Problem Solution 

QCCR1E
67071 

The Knowledge Management update process 
(KMUpdate) causes an unnecessary load on the 
Service Manager (SM) server with approximately 
15,000 to 20,000 extra logins per day. This, in turn, 
creates a lot of load on the Oracle database, 
licensing module, horizontally-scaled cluster 
communication, and many more. The KMUpdate 
process should have a companion 
KMStatusListener background process (which 
starts automatically when needed) and will update 
the status in SM without a need for a special web 
service servlet container.  

A new background process 
(KMStatusListener) has been 
implemented that replaces the web 
service listener and updates status and 
error knowledgebase records using 
JavaScript. 
To take advantage of this server-side fix, 
users must also apply the 
QCCR1E67072_SM930P3.unl file, which 
is available in the platform_unloads 
directory.  

Note: This fix works only for Service 
Manager applications versions 7.11 and 
9.2x, which support the K2 search engine. 
For applications version 9.30, which 
supports only the SOLR search engine, 
there is no need to load the above unload 
file. 

QCCR1E
67946 

Slow system performance occurred and reviewing 
the system status revealed that several background 
processes were idle for over three hours. 

Fixed the Service Manager load balancer 
so that load is now distributed evenly 
across all available servlet containers. 

QCCR1E
67910 

The fourth parameter of RAD function 
generate.sql.query() will not take effect when a 
boolean value is passed, whether it is true or false.  

The fourth parameter will be taken into 
account when a Boolean value is passed.  

QCCR1E
68005 

When a user connects through Trusted Sign-on 
(TSO) and exceeds the maximum number of 
concurrent logins, the server gives an error 
message.  

When the Service Manager client log-in 
fails, the correct message(s) will be 
displayed.  
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Global 
ID 

Problem Solution 

QCCR1E
68081 

When trying to start Service Manager, users 
encounter a null pointer exception error:  
Exception in thread "main" 
java.lang.ExceptionInInitializerError 
Caused by: java.lang.NullPointerException 
at 
com.hp.ov.sm.common.auth.AutoPassClient.getF
eatures(AutoPassClient.java:48) 
at 
com.hp.ov.sm.common.resource.LicenseData.ver
ifyLicense(LicenseData.java:114) 
at 
com.hp.ov.sm.common.resource.LicenseData.ini
tData(LicenseData.java:213) 
at 
com.hp.ov.sm.common.resource.LicenseData.ini
tializeAutoPass(LicenseData.java:66) 
at 
com.hp.ov.sm.common.core.Init.initializeLice
nse(Init.java:347) 
at 
com.hp.ov.sm.common.core.Init.getInstance(In
it.java:147) 
at com.hp.ov.sm.common.core.Init.getInstanc 
 
Error! initializing java in scjvm.cpp 
 

In addition, error messages similar to the following 
appear in the sm.log file: 

 
26219( 1) 08/11/2011 16:06:55 JRTE I Java 
version: 1.6.0_21 
26219( 19) 08/11/2011 16:06:55 JRTE I 
Starting Memory Monitoring thread to check 
for memory every 15 seconds. 
26219( 1) 08/11/2011 16:06:55 JRTE E 
Autopass Initialization Failed. Error Code: 
2013 Message: 2013 
26219( 1) 08/11/2011 16:06:55 RTE E Unable 
to Find Class com/hp/ov/sm/common/core/Init 
by ThreadId 1 
26219( 1) 08/11/2011 16:06:55 RTE D die: 
entered 
26219( 1) 08/11/2011 16:06:55 RTE E HP 
Service Manager is unable to start.  

When checking for existence of the license 
file, Service Manager no longer generates 
the null pointer exception and will report 
the correct error statements in the sm.log 
file.  



 21 

Global 
ID 

Problem Solution 

QCCR1E
68200 

The displayed data List was incorrect after using 
Customize Current View when adding a field. 
 
Here is an example scenario: 

1. Log in to Service Manager as a system 
administrator. 

2. Select Interaction as Queue on the To Do Queue 
page. 

3. Select All Open Interactions as View.  

4. Click Count Records. The number of records 
(for example, 198) is displayed. This is correct. 

5. From the More or More Actions menu, click 
Customize Current View. 

6. Click Fields and then add "Contact Full Name" 
to the List. 

7. Click Finish. 
Only four records are displayed. After clicking 
field "Contact Full Name", only two records are 
displayed. This is incorrect.  

The displayed data List will be correct 
after the user adds a field to the list using 
the Customize Current View option.  

QCCR1E
68788 

Performing a column sort in a View produces an 
error and client termination in UNIX-based 
systems.  

No errors occur when performing a 
column sort in a View.  

QCCR1E
69280 

When an Employee Self Service (ESS) user accesses 
Service Catalog, the following debug message is 
written to the server log for every image displayed 
in the Service Catalog: "attachmentCompressed = 
false, Calling compress!"  

The attachment debug message will no 
longer occur unless the debugattachments 
parameter is enabled. 

QCCR1E
69423 

After the RTE binary patch P3HF4 and web client 
P3HF4 were applied, there were issues when users 
worked in the web client. They often received the 
following error: "Logout successful". 

The "Logout successful” error no longer 
occurs. 

QCCR1E
69687 

When the Search Engine server is not running or is 
disconnected from Service Manager, the KMUpdate 
process fails with a signal 6 in the sm.log and a core 
dump written to the disk.  

Introduced a new exception handling 
strategy to handle any error or exception 
from the Search Engine server. No matter 
whether the Search Engine is down or 
not, the KMUpdate process keeps 
running, unless the process is terminated 
manually.  
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Global 
ID 

Problem Solution 

QCCR1E
69693 

Language preference is ignored when Trusted Sign 
On (TSO) is enabled on the client side (either 
Windows or web). 

Language preference works properly when 
TSO is enabled on the client side (either 
Windows or web). 

Note: This is the server-side change for 
this issue. Users must apply this change 
together with the client-side change 
QCCRIE61860. 

QCCR1E
69902 

When running sm -reportsem, the Diagnostic 
Service can encounter performance issues and 
semaphore/mutex wait times. The overall system 
performance may suffer.  

A new parameter "degugdiagnostics" has 
been introduced, which by default disables 
the Diagnostic Service. To enable the 
Diagnostic Service, specify 
debugdiagnostics:1 in the sm.ini file or the 
server OS command prompt.  

QCCR1E
69941 

Memory leak occurs when running the SCEmail 
agent. This memory leak condition can be captured 
in the Service Manager log file with the debug 
parameter memdebug:400 set.  

Memory is freed after the SCEMail is 
finished.  

QCCR1E
70014 

A Signal 11 error occurs when creating a production 
patch using an Oracle database and a Unix Service 
Manager server.  

No Signal 11 error occurs when creating a 
production patch using an Oracle 
database and a Unix Service Manager 
server.  

QCCR1E
70053 

When using an unsupported SQL data type in a 
SQL mapping in Service Manager during a record 
insert, a corrupt error message is displayed. 

Now, when using an unsupported SQL 
data type in a SQL mapping in Service 
Manager during a record insert, the 
correct error message is displayed 
including the numeric representation of 
the unsupported data type. 

QCCR1E
70184 

The number of database connections increases over 
time until no further connections remain.  

The resource leak, which was introduced 
by HTTP GET requests, has been fixed.  

QCCR1E
70218 

Cannot load unload files from a DB2 system into an 
Oracle system. 

Now users can load unload files from DB2 
with no problem. 

QCCR1E
70544 

The Service Manager server experiences high CPU 
load and servlets stop responding to client requests. 
Over time, an administrator has to restart the 
service to recover from this condition.  

This high CPU load issue has been 
resolved.  
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Global 
ID 

Problem Solution 

QCCR1E
71341 

If the directory path of JAVA_HOME contains a 
white space, executing wsdl2java.bat and 
runDocumentImport.bat will cause errors. 

When the directory path of JAVA_HOME 
contains white spaces, wsdl2java.bat and 
runDocumentImport.bat can run 
successfully. 

Note:  This fix is released with 
9.30p3HF8. To take advantage of this fix, 
find the sm9.30.225-P3HF8_KM.zip file in 
this hot fix. 

Application updates 

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E67072 Improve the Knowledge Management update 
process (KMUpdate) performance by 
removing the companion web service 
servletcontainer and adding a companion 
KMStatusListener background process 
(which is started on demand without any 
administration).  

A new KMStatusListener process will 
start on demand without any 
administrative need and will update, 
delete, and insert documents into the 
relevant KM module tables. 

Important: To take advantage of this 
change, you must load 
QCCR1E67072_SM930P3.unl, available 
in the platform_unloads directory. 

Note: This change takes effect only on 
the K2 search engine; this change is not 
needed if the SOLR search engine, which 
has been supported since SM9.30, is 
used. 

QCCR1E67647 Need to update the exception message that 
occurs in the request response when closing 
an interaction by calling CloseInteraction 
from a web service without specifying the 
localSolution field in the request. 

Updated the following scmessage record 
from "Doc Engine call failed with cc %d" 
to "Doc Engine call failed with cc %d 
msg: %s": 

• Message Number: 19 

•  Class: scxmlapi 

QCCR1E70163 The KMUpdate process terminates 
abnormally when it is not terminated 
manually or when internal errors do not 
occur.  

When the Search Engine server is shut 
down or an indexing document error 
occurs, the KMUpdate process will not 
terminate, and error messages will be 
written to sm.log to indicate the 
exception details.  
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Documentation changes 

The following items are fixed in the current software release.  

Global ID Problem  Solution  

QCCR1E66827 A NullPointerException occured in the 
WebSphere 7.0 logs (System.out), when 
the local class loader was set to parent 
first and the class loader order was set 
to parent last.  
 
When the class loader order was 
changed so that the web application 
used the local class loader first (parent 
last), the null pointer exception was 
fixed; however this configuration did 
not allow Java applets to work (CI 
Visualization and CTI). This was 
because the applet could not find 
needed Java classes.  

HP recommends using the following deployment 
procedure: 

1. Deploy the .ear file of the Service Manager 
web tier on WebSphere 7.0.  
Note: The .ear file contains the .war file. 

2. Configure the Service Manager web 
application as follows: 

a Go to Enterprise Applications > HP 
Service Manager *** Web > Class loader, 
and select the following settings: 

 Class loader order: Classes loaded with 
local class loader first (parent last) 

 WAR class loader policy: Single class 
loader for application 

b Go to Enterprise Applications > HP 
Service Manager *** Web > Manage 
Modules > webtier-***.war, and select the 
following setting: 
Class loader order: Classes loaded with 
parent class loader first  

QCCR1E71179 When Service Manager is running on 
RTE version 9.30 with an Applications 
version earlier than 9.30, the Smart 
Icons feature may cause performance 
issues to the server. 
This is because in pre-9.30 Applications 
versions, the Smart Icons feature 
causes overhead on display of every 
ticket by determining if the button 
should be active and what color it 
should be.  
With the changes made in Applications 
version 9.30, the Smart Icons feature 
still works, however the overhead is 
caused only when users press the 
button.  

Updated the Service Manager 9.30 release notes 
by documenting this known issue 
(QCCRIE71179) and providing the manual steps 
to disable the Smart Icons feature. The updated 
release notes document is available from the HP 
software manuals 
site: http://support.openview.hp.com/selfsolve/doc
ument/KM1195793.  

http://support.openview.hp.com/selfsolve/document/KM1195793�
http://support.openview.hp.com/selfsolve/document/KM1195793�
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Known Problems, Limitations, and Workarounds 

This software release has the following known issues. 

Global ID  Known Issue  Workaround  

QCCR1E28000 If the Equal sign (=) is the first 
character in an array field, it will be 
truncated. 

No workaround is available at this time.  

QCCR1E68803 The help topic "Hardware load 
balancers" refers to functionality 
not available in the 9.30 release. 

This topic should be removed from the 9.30 help. The 
functionality may become available in a future 
release. 

QCCR1E57385 When Service Manager is running 
on Unix, the legacy listener may log 
intermittent signal 11 upon CIT 
initial connectivity test if exec-
shield is not set properly.  

Use the workarounds to solve this issue.  

Solution 1: 

Connect Connect-It to the Web Services connector 
instead of the Legacy Listener connector. 

Solution 2: 

Before connecting Connect-It to the Legacy Listener 
connector, do the following: 

1. Add  usethreading:0 in the sc.ini file, which is 
located in <Service Manager server installation 
path>\LegacyIntegration\RUN. 

Note: For 64-bit RedHat Linux servers only, you 
can alternatively run the following shell 
commands as root: 

 # sysctl -w kernel.exec-shield=0 

 # sysctl -w 
kernel.randomize_va_space=0 

2 Start the legacy listener. 
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Installation Notes 

Digital signature notice 

HP signs Windows executable files with a digital signature. For SM 9.30.p3, this process has been updated 
to use a new VeriSign root certificate. On a Windows system that does not have the new VeriSign root or 
intermediate certificate installed, when the user right-clicks the file and then goes to Properties > Digital 
Signatures > Details, a verification error will display: “The certificate in this signature cannot be verified.”   

 

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as 
documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140 

Web tier installation 

The Web Tier update consists of a compressed file, sm9.30.201-P3_Web_Tier.zip. The specific upgrade 
process depends on your particular Web application server, but follows the same steps as deploying a new 
installation. 

The Service Manager Web Tier contains a J2EE-compliant web application that runs on your web 
application server. Each web application server has its own method of deploying web applications. See your 
web application server documentation for specific instructions on deploying a web application. 

The upgrade does not automatically save your Web Tier customizations. To keep your changes, you must 
save your customized files and replace the new version of these files with your customized version. For more 
information, refer to the Service Manager Interactive Installation Guide. 

Note: For an updated example of deploying the web tier, see Deploying the Service Manager Web Tier on 
WebSphere Application Server 7, included in the Service Manager 9.30p2 Release Notes. 

Note: Arabic language support requires Internet Explorer 8. 

https://knowledge.verisign.com/support/ssl-certificates-support/index?page=content&actp=CROSSLINK&id=SO19140�
https://knowledge.verisign.com/support/ssl-certificates-support/index?page=content&actp=CROSSLINK&id=SO19140�
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1. Back up your web.xml file, splash screen, style sheets, and any other customizations you made, 
including your webtier-9.30.war (webtier-ear-9.30.ear) file.  

2. Delete or uninstall the existing webtier-9.30.war or webtier-ear-9.30.ear file. 

3. The "Update Application" function in WebSphere application server allows you to redeploy using a new 
copy of webtier-9.30.war (Webtier.ear-9.30.ear). First, update the web.xml in the webtier-
9.30.war (.ear) file, and then redo the shared library configuration. For more information, see the 
IBM WebSphere documentation. 

4. Deploy the new webtier-9.30.war (.ear) file by following the instructions in the Service Manager 
Installation Guide.  

Note: HP recommends that you deploy with a unique context root, for example /webtier-9.30.201. 

5. Replace the new versions of any files you customized with your customized versions. 

6. Make any new customizations necessary for your deployment. 

7. Restart the Application server.  
Note: Before accessing the new Web Tier, HP recommends that all users empty their browser cache. 

Windows client installation 

The Windows client update consists of a compressed file, sm9.30.201-P3_Windows_Client.zip, which 
contains the executable installation files. 

To install the Windows client update: 

1. Stop the Service Manager Windows client. 

2. Uninstall the Service Manager Windows client. (Your connection and personalized settings are retained.) 

3. Run setup.exe and install the client by following the instructions in the Service Manager Installation 
guide and Release Notes for your version. 

4. Check the version in Help > About Service Manager Client.  
The client should be Release: 9.30.201. 

Server installation 

The server update for your operating system (OS) consists of a compressed file, sm9.30.201-P3_<OS>.zip  
(or .tar), which contains the Service Manager server files. These files add to or replace the files in the  
[SM Root]\ ([SM Root]/) RUN, irlang, legacyintegration, and platform_unloads directories. 
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To install the Server update: 

1. Stop all Service Manager clients. 

2. Stop the Service Manager server. 

3. Make a backup of the RUN directory. 

4. Extract the compressed files for your operating system into the main Service Manager directory on the 
server. The default path is: C:\Program Files\HP\Service Manager 9.30. 

5. For UNIX servers, set the file permissions for all Service Manager files to 755. 

6. Restart the Service Manager server. 

7. Restart the Service Manager clients. 

8. Check the version in Help > About Service Manager Server.  
The server should be Release: 9.30.201. 

Application unload installation 

The application consists of the unload files that come with the server update. When you extract 
sm9.30.201-P3_<OS>.zip (or .tar), the new files are added to your  
[SM Root]\platform_unloads ([SM Root]/platform_unloads) directory. 

Unload file naming convention 

The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where: 

• <CR_ID>: The identification number of the applications defect that the unload file fixes. For example, 
QCCR1E12345. Note that this is always the number of the parent CR of a CR family (if any). 

• SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example, 
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 patch 2 
and should be used for patch 2 or higher.  

Note: Sometimes this portion contains an additional hot fix number, for example, SM711P16HF8. This 
example means the unload file is intended for Service Manager 7.11 patch 16 Hot Fix 8 or higher.  

• SMxxx: The Service Manager applications version that requires the unload file. For example, SM711, 
which means the unload file is intended only for Service Manager applications version 7.11. 

Note: If the applications version suffix is omitted, the unload file is then intended for all applications 
versions compatible with the server version, unless otherwise specified. For example, 
QCCR1Exxxx_SM930P4.unl is normally intended for applications versions 7.11, 9.20, and 9.30 (which 
are compatible with Service Manager server 9.30), unless otherwise specified in the unload file 
description. For information on the applicable applications versions for each unload file included in the 
current patch, see Unload Files Included in the Current Patch. 
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Unload Files Included in the Current Patch 

New application updates in the current patch 

The following are new unload files introduced in the current patch release. 

Unload file from 
9.30 
patch 

Used for 
applications 
version(s) 

Description 

QCCR1E67072_SM930P3.unl P3 7.11 and 9.20 Enables users to take advantage of the 
new KMStatusListener background 
process. 

Note: This unload file is not needed for 
applications version 9.30, which 
supports only the Solr Search Engine. 

QCCR1E67647_SM930P3.unl P3 7.11 - 9.30 Updates the exception message that 
occurs in the request response when 
closing an interaction by calling 
CloseInteraction from a web service 
without specifying the localSolution 
field in the request. 

Note: This unload file is required after 
applying the server fix QCCR1E54192. 

QCCR1E67750_SM930P3_SM930.unl P3 9.30 Enables users to specify their search 
result sort preferences in Knowledge 
Management (by Modified Date, 
Status, or Relevancy). 

Note: The search result sort 
preferences feature in this release has 
several known issues. If you have not 
yet installed it, ignore this unload file. 
If you want to enable the sort 
preferences feature, install the KM 
Search Engine update provided in the 
9.30p4 release instead.    

QCCR1E70163_SM930P3_SM711.unl P3 7.11 Fixes the issue that the KMUpdate 
process terminates abnormally. 

QCCR1E70163_SM930P3_SM920.unl P3 9.20 Fixes the issue that the KMUpdate 
process terminates abnormally. 

QCCR1E70163_SM930P3_SM930.unl P3 9.30 Fixes the issue that the KMUpdate 
process terminates abnormally. 

Application updates in previous patches 

Additional application updates have been included with this cumulative release. If you have not already 
applied them for a previous patch, you should also apply the unload files that are used for your applications 
version (see the following table). For more details about these applications updates, see the Release Notes for 
those patches, also included with the release. 
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Unload file from 9.30 
patch 

Used for 
applications 
version(s) 

Description 

QCCR1E67610_SM930P2.unl P2 7.11 - 9.30 Enables you to block potentially 
dangerous attachments. 

To load an unload file: 

1. Select either client or server-side unload, depending on the location of the unload files. 

a From the Windows client, go to Window > Preference > HP Service Manager. 

b Flag Client-Side Load/Unload if the files are on the client machine, and clear the flag if they are 
on the server. 

c Restart the Windows client if you changed the setting. 

2. Open Tailoring > Database Manager. 

3. Right-click the form or open the options menu and select Import/Load. 

4. Fill in the following fields. 

Field Description 

File Name Type the name and path of the file to load. 

Import Descriptor Since unload files do not require an Import Descriptor record, leave this field 
blank. 

File Type Select the source operating system of the unload file. 

Messages Option —  
All Messages 

Select this option to see all messages that Service Manager generates loading the 
file. 

Messages Option —  
Totals Only 

Select this option to see only the total number of files Service Manager loads. 

Messages Option — 
None 

Select this option to hide all messages that Service Manager generates when 
loading the file. 

Note: You can view the contents of an unload file before importing it by clicking List Contents. 

5. Click Load FG. 

Verified Environments 

The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software products, 
and other compatibility and support information.  

To access the Compatibility Matrix:  

1. Use a browser to navigate to the Software Support Online (SSO) web page:  
http://support.openview.hp.com/sc/support_matrices.jsp 

2. Log on with your Customer ID and password or your HP Passport sign-in.  

3. Navigate to the applicable information.  

http://support.openview.hp.com/sc/support_matrices.jsp�


 31 

Local Language Support 

UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script and 
language. Service Manager 9.30 supports UTF-8 as an encoding method for new or existing data. It can 
support multiple languages that adhere to the Unicode standard on the same server. 

Support 

You can visit the HP Software support web site at: 
www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 
http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 
http://h20229.www2.hp.com/passport-registration.html 

http://h20230.www2.hp.com/new_access_levels.jsp�
http://h20229.www2.hp.com/passport-registration.html�
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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notice 

© Copyright 1994-2012 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

• Adobe™ is a trademark of Adobe Systems Incorporated. 

• Java™ is a registered trademark of Oracle and/or its affiliates. 

• Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation. 

• Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California. 

• UNIX® is a registered trademark of The Open Group. 

For a complete list of open source and third party acknowledgements, visit the HP Software Support Online 
web site and search for the product manual called HP Service Manager Open Source and Third Party 
License Agreements. 
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